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1. Installation and Activation
1.1 Installation
This software comes with a standard Windows installation disk. You can either get a
physical CD disk, or download the software from web. The MusicWriter software is
shared among music lovers for free. Please do not use it to make any profit. The free
download site is:
http://musicwriterxu.com/
Step 1. If this is first time you install the MusicWriter, go to step 2. Otherwise you need
to uninstall previous version of MusicWriter. To do so, you need to use Add/Delete
Program function in Windows Control panel. Please do not directly delete all
previously installed MusicWriter files. Uninstall will not delete your existing data,
including the music you have created.
Step 2. The compressed file you downloaded contains a installation file
called :MusicWriterXXX.exe”. You need first use WinZip or other compatible utilities
to unpack the file then execute the MusicWriterXXX.exe by double click on it. You
should be able to download WinZip on the web for free.

Run this setup
program

Unpack this
file.

Step 3. You should see a screen like:
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Click on “Next” all the way through the installation until it finishes. You can accept all
default settings until you have a reason to change them.

1.2 Activation License
Even it is free, this software is still protected by license so I can track how many users are
use it. If this is the first time you install the software, you will get a 30 day free trail
period. The trail version has all the functionality except it cannot print the music. You
need to get a permanent license after 30 days otherwise the software will stop to run.
If you do not have a legal license, when you start MusicWriter, a Software License
window will pop up first (see below). You need to send (email) the computer id which is
shown on the screen to the author. The author will then email back the license number.
You type in the license number on the same window below the computer id to finish the
license installation.
Both the computer id and the license are 8 digits numbers. The licenses are unique to
each computer and cannot be transfer to other computers. However, you do not need a
new license if you install an update.
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The Software License window can be displayed in either English or Chinese (assume you
have Chinese font installed)

Send this id
to the Author

Type in the
license number
here

This is the same license window displayed in Chinese.
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1.3 Install Music Fonts
In order for the program run perfectly, we need some music fonts. These fonts will be
installed automatically during installation process. However, if there some reason the
fonts are not installed correctly, program will still be able to run correctly though some
advanced symbols may not be shown or shown incorrectly. In such case, the following
window will pop up when program starts:
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2. Introduction
2.1 Music Notation System
The numbered music notation system, also called cipher system, was believed to be
introduced by Jean-Jacques Rousseau in 1742 but is widely used in China and other
Asian countries today. It has a Chinese name called “Jianpu”, which means simplified
notation. Throughout this software and documentation we will call it “Simplified
Notation”, or “Simplified”. In contrast, we will call the modern music notation system
“Western Notation” or “Western”
For more information about numbered music notation system, please visit the Wikipedia
entry about it
http://en.wikipedia.org/wiki/Numbered_musical_notation#Musical_note
Or if you prefer the Chinese version, go to
http://zh.wikipedia.org/wiki/%E7%B0%A1%E8%AD%9C
This software is designed to create music in both the numbered notation system as well as
in the modern music notation system. This software originally was specially designed
targeting to the numbered notation system， however, as it continue improves, it now has
all needed functions to create Western notation music piece.

2.2 Terminology Used in Simplified Notation
This documentation is not intended to explain the Simplified notation system. But to
make the documentation easier to read, we need to standardize the English terminologies
used in this software. Fortunately, most of the terminologies used in Simplified notation
are the same as in the Western notation, such as chords, grace notes, measure, bars, repeat
bars, etc. These terminologies are already standardized in English and also have a
standard Chinese translation. However, the ones that are unique to the simplified
notation often do not have standard English translation and we need to define them here.
Music Note
Also called Note, is the number 1, 2, 3, 4, 5, 6, 7 and 0. Letter x and X can also
be used as special note for percussion instruments such as drums. We also allow
the “*” sign as a special note. The “*” is used in some Chinese instrumental
music pieces.
High and Low Octave Dot
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Also called High and Low Dot. They are used to indicate an octave higher or
lower. It is marked directly above or below the note. A note can have more than
one high or low dot but it cannot have both high and low dots at the same time.
Underline
Marked directly under the note, it is used to indicate the time length. A note can
have more than one underline. A note without any underline is a quart note. Each
additional underline will reduce the time length of the notes by half. For example,
2 will be an eighth note. The underline is very similar to the “note tail” in western
notation system.
Dash
Also called Extend Line, it is a short line after a quarter note. It is used to extend
the time length (duration) of the quarter note another quarter beat. A quarter note
can have no more than three dashes. Each additional dash extends its length
another one quarter beat.
Appended Dot
Also simply called Dot, is a dot after a note. It is used to extend the note half of
its original time length. A note can have more than one appended dot. The second
dot extends the note additional one fourth of it original time length, and so on.
This is very similar to the “dotted note” concept in western notation system.
Tone Symbol
We will always use the “1 = X” format to mark the tone symbol. For example, 1
= G means tone G. Tone symbol should appear before the first note in the music,
or where the tone changes in middle of the music. The tone symbol should
always be marked above the music line.

2.3 Simplified Notation Format Guideline
For now, there is no universal format standard to writing simplified notation music. Here
are some guidelines we used in this software. You do not necessarily need to follow the
guidelines. But if you do not, some tasks may not function correctly, such as converting
between Simplified and Western, breaking individual component from the composed
music, or play the music, etc.
Bar Line
Bar Lines are used to divide the measure. There should be no bar line at the start
of the music line when the music piece is for a single instrument (分谱). For
example:
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Double Bar line
Double bar lines should be used at the end of the music. Sometimes double bar
line can also be used at the end of a section for music that has multiple sections.
For example:

Full Score Music
Full score music (总谱) consists of music for multiple instruments/vocal, and/or
two hands of the same instrument, such as piano. One should use brackets or
braces to group the instruments at the beginning of each music line. The
following example uses bracket:

The following two examples use braces：
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In many cases the bracket is used to combine the group of similar instruments while the
brace is used for the both hands of the same instrument such as piano and Gu-Zheng(古
筝).

2.4 Overview of Program Interface
The program interface is designed using standard Windows application conventions. At
the very top is the program title bar, which also shows the program version number.
The next line down is the Menu bar. It contains 10 menus: File, Edit, Text, Modify,
View, Western, Tool, Image, Windows and Help. The individual items under each menu
are called the menu items. Some menu items also contain sub items.
Next line down from the Menu bar is the Toolbar. The Toolbar contains icons to launch
the most frequently used actions, such as open file, save file, etc. All functions in the
toolbar can also be found in the menu.
On the left side of the window there is a Left Toolbar that also contains several often
used functions, such as add underline, high and low octave dot, etc.
At the very bottom there is a Status Bar. The status bar displays information such as the
page number, file name and other information as it is available to the use.
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There are six floating windows that supply many additional objects and functions for you
to use. They are:
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Virtual Keyboard Window – This will bring a virtual keyboard at bottom of the
screen. Details see section 15.



Gongchi – Gongchi is a traditional Chinese music notion system. It still used
today on some Chinese Opera and other cases. When this Window opens, the
software enters so called GongChi mode and will allow you choose the GongChi
characters and symbols from it and add to the music. Details see section 16.

The float windows can be hidden or visible. To show or hide the floating windows, click
on the icon
from toolbar respectively, or select the corresponding
menu items from the Windows menu.
Many menu items or icons have a shortcut key. You can quickly execute these functions
by simply pressing the shortcut keys. To view the shortcut key for menu items, open the
menu and looking for the key symbol on the right side of the menu item. For the icons on
the left bar and on the floating windows, you can hover the mouse point over the icon and
a popup hint box will display the shortcut key. You must set your keyboard in nonChinese mode to use shortcut correctly。

Shortcut

Shortcut
“=” for slur

In the middle of the screen is the work area. The work area is divided into grids. Each
individual unit is called a “Cell”. User can select a single cell or blocks of cells. The
border of the selected cells is highlighted in blue. All user input will apply to the selected
cells.
If you click on the right mouse button when the mouse point is in the working area, a so
called quick access menu will popup that will allow you access to some commonly used
functions. The contents in the quick access menu may be different depending on what is
currently selected.
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We need point out that there are some red portion on some icons, such as , , etc. This
means if this function apply to an existing object, then only red portion will be add to the
existing object. For example, icon on the left toolbar will add high dot to an exsiting
note, will add high sharp sign to an exsiting note, icons
coresponding modifier to an existing note.

will add

Quick access
menu

2.5 English and Chinese Display
The software can be displayed in either English or Chinese. To switch between these two
languages, you can simply press F7 key, or choose “Use Chinese Version” or “Use
English Version” item in Help menu.
Please note that if you are running English version of Windows OS, you need to setup
your environment correctly in order to run Chinese version. Please see document “How
to Setup Chinese for MusicWriter.doc” for details. If you are running Chinese version
Windows OS, you should be able to run the software in Chinese without additional work.

2.6 Cells
A Cell is the basic unit of the music sheet. Each cell can contain one note (including
append dot and dash), or two to three symbols arranged vertically. For example:
All Rights Reserved
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Cell contains
two symbols

Cell contains
one note

A cell cannot contain a note and a symbol at the same time except for certain cases which
will be explained later. A cell can also host a dynamic mark. A dynamic mark can
co-exist with a note or symbol at the same cell. For example:

A slur co-exists with
note 2 on the same cell

At above example, the slur mark is co-exists with note 2 on the same cell even though the
slur is displayed above the cell and cross two cells. We will explain this phenomenon
later in section 3.4.
A cell can also contain a text string. A text string can be any English or Chinese
character string. Though it can run much longer then the cell width, a text string actually
belongs to a single cell where the text starts. We will discuss the text in more detail in
section 3.7.
The cell always has a 1:2 width to height ratio. The size of all objects on the music is
automatically determined by the cell width, which includes notes, symbols, marks
and texts. You can change the cell width in the preference dialog.
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3. Create Basics Music
Note: Before creating a new music piece, please make sure your paper size and cell size
is set properly. Even though you can change the paper size and cell size later but that
can be painful after data is entered. You can set these parameters in the Preference
dialog, see section 8.1 for details.

3.1 Select Cells
You need first to learn how to select cells because all operations are applied to the current
selected cells.
1. To select a single cell, simply put the mouse cursor on that cell and click the left
mouse button.
2. If you put the cursor on a cell and then press and hold the left mouse button, the
cursor will change to a diagonal arrow shaped like . Now you can drag the
mouse while holding the left button to select a block of cells.

3. Another way to select a block cells is to select the top-left cell as mentioned in
method 1, then hold the Ctrl key and click the left mouse button on the bottomright cell.

Click on this
cell first
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4. Yet another way to select a block cells involves no mouse. Simply holding the
ALT key and pressing one of the arrow keys the selected box will be extended
along the direction of the arrow.
5. There are two quick ways to select a row of notes that are separated by space:
simply holding the Alt key and click on any note in that block. Or you can simply
double click on any note in that block.

A row of
notes

6. There are two quick ways to select a single row or column:
a. Holding the Shift key and click on any cell on that row will select a entire
row.
b. Move cursor to the left or top margin of the page, the cursor shape will
change to a hand sign like
row or column.

. Click the mouse left button to select that

Move cursor to the left
margin and click.

Hold Shift key and
click on any cell on the
row.

7. There is a quick way to select entire page (all cells on the page) by simply
pressing Ctrl + A, or choosing menu item Select All in Edit menu.
You can resize the selected area by mouse. Simply move the mouse cursor close to the
right or bottom edge of the selected rectangle, the mouse sharp will change to
, or
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respectively. Then press the mouse left button and drag the mouse to change the
selection rectangle.
You can move the selection box by pressing the left, right, up or down arrow keys on the
keyboard.

3.2 Add Basic Object


To add a music note, select the cell and type a number between 0 and 7, *, or x
and X for percussion instruments. The note will be default to 4th note. However,
you can change the default to 8th or 16th note by pressing the F1 key, all the notes
entered afterward will automatically be the 8th or 16th note.



To add a dash (extend) line, select the cell and type “-“(the minus key on the
keyboard.)



To add the appended dot, select cell and type “.” (The period key on the
keyboard). In this way the dot occupies a cell. You can also use icon
on the
Left Bar to add a dot. This way the dot is directly added to current selected note,
not occupied a separate cell line in first method.



To add the underline for the note(s), select the note(s) and then type “_” (the
underscore key on the keyboard.) If you keep press the “_” key, additional
underline will be added to the notes. After the number of underlines reaches 3, it
cycles back to 0. To enter more than 3 underlines, use the menu item “add
underline” from the quick access menu. You can also use the icons from the Left
Bar ( , , and ）to change the underline.



To add low octave dot, select the note(s) and then type “,” (the comma key). If
you keep pressing the comma key, additional low octave dot will be added. After
the number of dots reaches 3, it cycles back to 0. To enter more than 3 dots, you
can use the menu item “Low Dot” from the quick access menu. You can also use
the icons from the Left Bar（ ， and ） to add or remove the low octave
dot.



To add high octave dot, select the note(s) and then type ’ (the apostrophe key). If
you keep pressing the apostrophe key, additional high octave dot will be added.
After the number of dots reaches 3, it cycles back to 0. To enter more than 3 dots,
use the menu item “High Dot” from the quick access menu. You can also use the
icons from the Left Bar（ ， and ）to add or remove the high octave dot.



To add the bar line, select the cell(s) and press the “|” key. You can also use the
icons on the Left Bar to enter the single bar, double bar ( , , ), or repeat bar
( , ).
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The icon
on the left tool bar will equal to repeat bar
bracket to form a repeat bracket:



You can have a repeat bar that has three dots for repeating three times like .
First add a normal repeat bar, then select the bar and press the ‘ key (the
apostrophe key on the keyboard). This will change the repeat bar to three dots.
Type the ‘ key again will change the repeat bar to one dot, then cycles back to 2
dots. You can also use the quick access menu. Selecting a repeat bar, then rightclick on mouse to bring up the quick access menu. Select Increase, Decrease, or
Reset from the menu to change the number of dots on the repeat bar.



To clear all contents of a cell, select the cell or block of cells then press the DEL
key.

. You can add it to

3.3 Add Special Symbols
All special symbols are located in the symbol floating window. To make the floating
window appear or disappear, select the icon from the Toolbar or select Special Symbol
menu item from Windows menu. This is what the floating window looks like:

All Rights Reserved
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Buttons to remove up,
middle and down
symbols individually

On the top of the float window contains 5 editing buttons. The first three buttons allow
you to remove the up, middle or down symbol individually. The last two buttons is used
to customize the symbol locations, which we will discuss them later.
The main portion of the float window contains multiple pages; each page contains many
symbol buttons. Click on the symbol button on the Symbol window will add the
corresponding symbol to the bottom of the selected cell. To add a symbol at the top or
middle of the cell, hold the Alt or Ctrl key while clicking on the symbol button. See
below example:

To remove the symbol, press the DEL key, all symbols in selected cell will be removed.
To remove only the top symbol, press Alt + DEL. You can also click on the buttons on
the top of the window to remove top, middle or bottom symbol individually.
The flat, sharp, nature and other symbols, which are shown in red on the panel, can coexist with notes. Selecting a note cell and clicking on one of the red icons will add the
corresponding sign to the front or top of the note. If the selected note already has the sign
associated, this will remove the sign. See below:

Sharp symbol
associated with the note
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This is a better way to associate the note with a sign rather then add the sign in the cell
before or above the note. This is not only save a cell, but more important is to make
system easier to associate this note with the sign, therefore function such as the
converting to west or playing music will be easier.
Using the icon , , or in the Left Bar can do the same thing. You can also use the
same way to add flat, sharp and nature symbol to individual notes inside a vertical (cords),
shrink, or grace notes. We will discuss them in details in chapter 6.

3.4 Add Dynamic Marks
Marks, also called Dynamic Marks, are located in the Dynamic Mark floating window.
To make the floating window appearing, select the
icon from the Toolbar or select
Dynamic Mark menu item from Windows menu. Similar to the Special symbol window,
it also has a top strip that contains several editing buttons. This is what the floating
window looks like:

Most of time a dynamic mark will be displayed across several cells, though it actually
only occupies one cell. To add a mark, first select a block of cells, and then click on the
corresponding mark icon from the floating menu. The top-left corner cell of the
selected block is the owner cell of the mark. For example:
Owner Cell

Owner Cell
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Though the mark can co-exist with note in the same cell, some marks will change their
default position when co-existing with a note. These marks have their icons shown in
red. For example, when the slur mark co-exists with a note, it will show on the top of the
note instead of at the bottom of the cell such as its default position:

There are two kinds of slurs. One
is based on ellipse arc and another one
on circular arc. You can choose either one based on your preference.

is based

Elliptical vs. circular arc slur
Edit Dynamic Mark Shape
There are many editing buttons on the bottom row of the float menu.

Change Mark
Vertical Size

Flip Mark
Vertically

Change Mark
Vertical
Length

Delete
Mark

Move Mark
end tail up
down
Move Mark up
down

Customize
button
position

All Rights Reserved
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: clear mark only. You can always press <DEL> key to clear the mark, but that
will clear all objects that co-exist in the same cell as well.
: flip the mark vertically. For example:

Note: The square and arc mark of triplet are the same. But if you flip the arc mark so
it will be at the bottom of the notes (or at the tail of the notes for western notation), then
only the number 3 will be shown. See example below:

: increase/decrease the vertical size of the mark:

All Rights Reserved
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Though you can also use
to move the mark up and down (see section 5.6), but
that will also move everything in the cell, include the note. This button will only
move the mark up and down.
: move the end tail of the mark up and down:

It can also be used to move the tail of diagonal and some horizontal marks (such as
slur).

To reset the mark to its original position and shape, simply click on icon

All Rights Reserved
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Note: The edit buttons for different dynamic marks may have different effect. You just
need to try to see how the changes are made.

3.5 Customize the Symbol and Mark Floating Window
There are tens or even hundreds buttons on the Special symbol and Dynamic Mark
floating window. These buttons are located on different pages. The customization will
allow you to have relocated some commonly used marks and symbols to the first page.
You even can have many different layouts saved, e.g. one for Erhu and one for Zhen.
These saved custom position then can be loaded later using icon
the top of the floating window.

, which located at

This is how the customization works:
1. Start customization by click on the button

from the top of the floating window.
Press this
button to start
customization

Use this button
to load a presaved custom
position file

2. After enter the customization, the floating window changes to:

All Rights Reserved
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3. Move the mouse cursor to the icon that you like to move its position. Then press
the mouse left button and drag the icon to the new position, then release the button.
The icon will then be moved to the new position.
4．Use button
to save the customized position to a new file, Button
apply this position.
Press this
button to exit
customization

to save and

Press this one to
load an existing
position file

Press this button to save
and apply current position
Press this button to save
the position to a new file

5. When all down, press button
restore its original appearance.

to exit the customization. The float window will

3.6 Triplets and Multi-lets
You can use the

icon on the Dynamic Mark window to create triplets and multi-lets.

1. Select the block of notes that will be the triplets or multi-lets. e.g.

or
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2. Click on the
button in the Dynamic Mark floating window. A triplet or multilets slur will then be added:

If necessary, you can also create the triplet or multi-let marks by combining the slur and
text. However in this case the system will not recognize it as a triplet therefore some
function may not function correct, such as verify and playing.

3.7 Add Texts
Like marks, the text occupies one cell no matter how long it is. Staring from version 3.9,
we have added a new way to enter text while still keep the original method.
Method 1. Click on the icon on tool bar will let the program entering a so
called ”Enter Text” mode meanwhile the icon will displayed as pushed down. In such
case, a text edit strip will show up at current selected cell, see below. You can type the
desired text in the strip and then enter RETURN key or simply click on the check button
beside the strip to accept it. The program will stay in the “Enter Text” mode so you can
continue to enter text by select other cells. You can also change the settings of text by
click on the Setup button beside the strip. To exit this mode, simply click on the icon
again.
Add Edit Icon

Text Edit Strip

All Rights Reserved

Font Setup button

- 27 -

Xiaoshu Xu

MusicWriter™ User’s Guide

Method 2: We still keep the original way to enter text. To add text in this method, , first
select one cell that is the start location of the text, then choose “Add Text” from the Text
menu. The Add Text window will pop up (see below).
You can enter a single line or multiple line of text at a time in either English (or other
Latin languages) or Chinese. If multiple line of text is entered, each line of text will
occupy one cell. In this case, you can later move each line of text to the correct place.
This can be convenient when enter the music words.

The English text will be displayed in its default English text font while Chinese text will
use the default Chinese font that is set in the Preference menu.
If you check the Custom button, you can select any 73 Tm 0she while Chieyc1(y)20lf multt will
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3.8 Add Words of a Song
People use text to add words associated with a song. One of important fact is that the
words need to line up with the music. But the text string is positioned on its first letter.
Usually a printer has much higher pixels than the computer screen (also true for BMP
files). Therefore when a text string looks is lined up with the music but when print it (or
output to a bitmap file), it actually is not. Longer the text string is, worse the situation,
especially when the string contains spaces. Therefore when enter the words of a song,
please do not use long strings. The best is to break a long string to several short ones that
do not contain space. Each short string should no more than two letters.

3.9 Add Commonly Used Text Symbol
Using the Text Symbol float window, shown below, allows you to add some commonly
used text symbol to the music.

3.10 Other Misc. Items
Tone Symbol
The tone symbol is entered as a Text. One should following the suggested tone
symbol format such as “1 = G” or “1=bB”. Click on icon
on toolbar will bring
a window to assist you for entering the tone symbol:
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Time Signature
Click on the
icon from the toolbar to add a time signature. There should be at
least one time signature before the first music note.

Tempo Sign
Click on the
icon from the toolbar to add a tempo sign. If there is no tempo
sign, 100 bit per minute will be used.
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3.11 Work with Images
You can add bitmap or jpeg based images to the music.
1. Select a block of cells where you would like the image to be embedded.

2. Click on the
icon from the toolbar, or use the menu item Insert Image from the
Image menu. An image selection dialog will pop up. You can choose BMP or
jpeg file types.
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3. Click on Open button to add the image.

You ca] TJETBT1 0 0 1 199.i08. lso served
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3.12 Create Your Own Symbols
You can use the Insert Image function to create your own symbols. To do so, simply
create a bitmap (BMP or JPEG, JPEG is preferred since it occupies less memory, and it
prefer to have less 1 MB in size) file of the symbol. Keep the image width to height ratio
as the same as the cell, that is 1:2. To ensure the best printing quality, the image should
be at least 60 pixels wide. To add the custom symbol to the music, select a single cell
and then insert the image.

3.13 Add Background Image
You can add an image as a background of the music. The background image will apply
to all following pages until a new background image is added in a following page, or a
stop background is applied to the following page.
Please note that the image’s owner cell is always the cell at top/left corner. See picture
below：

The owner cell

3.14 Keep Original Aspect Ratio
If you checked the “Keep Original Aspect Ratio” under Image menu, the width and of the
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inserted image will determined by the width of selected area, and the height will be
adjusted based on the aspect ratio of original image. Otherwise the image will adjust
itself to fit into entire selected area, in the case of “Insert Full Page Image”, the image
will fit to cover entire page.

Keep Original Aspect Ratio

Fit into entire selected area

3.15 Open and Close Side Image
If your screen is wide enough, you can open an image on the side of screen. This is very
helpful when you enter music from a music sheet of JPEG or BMP format. See the
following example:
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4. Viewing Options
4.1 Navigate Through Pages
A music piece normally has more than one page. The icon group
on the
toolbar can be used to navigate through the pages. Use the dropdown box to go to
specific page, or use the arrow icons to go back and forth. If you are at the last page and
the last page is not empty, clicking on the
key will append an empty page.
Page up and down keys can also be used to navigate through the pages just like the arrow
icons. Using icon on toolbar back to first page.
You can always see the current page number and total page number on the status bar.

4.2 Zoom
There are various zoom options. These options can be found under the View menu.


Using menu item Zoom in the View menu, you can zoom the view from 50% all
the way to 500%.



Using Ctrl+F1, Ctrl+F3, and Ctrl+F5, you can zoom the view to 100%, 300%,
and 500%, respectively



A quick way is to use



Full View option in the View menu will make the page fit to the entire work area.



Switch View will switch back and forth between two views. On is normal view
and another one is enlarged view.



Select Slice View option will fit the page to the entire screen. The title bar,
toolbar and others are all hidden. Clicking right mouse button will go one page
forward while clicking the left mouse button will go backwards. To quit from
Slice view, simply press the <ESC> key. If you have a wider screen, there will be
two pages side by side shown in the same time (See following screen). The slice
view is a read only mode and no editing function is allowed. The slice view is the
perfect for reading the music or directly playing from the computer screen.
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When you zoom in, the software will always make sure that the current selected area is
visible in the view window.
The zoom value is persistent. That means that after you set a zoom value it will stay in
that value even when you exit and re-enter the program until you change it.

4.3 Other Misc. View Options


Show Grid – turns the grid on and off



Refresh – Repaints the entire page. Sometimes after editing, there is a old piece
of data that still displays on the screen. This is because only the editing area, not
the entire screen is repainted. These artifacts can happen when the editing object
is shifted out of position. Clicking on the refresh icon
will solve this problem.



Clear Highlight – After some operations, such as converting between Simplified
Notation and Western Notation, some cells may be highlighted to indicate
potential errors during the operation. Select this menu item will clear up the
highlights
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5. Editing
5.1 Move
There are two ways to move the content of selected blocks to a new location. The first
method is to use the mouse:
1. Select an area whose contents you would like to move.
2. Move the mouse point close to the top or left edges of the selection box. The
mouse cursor will change to a cross arrow shape
drag.

to indicate you can start to

Move mouse
cursor to this
area

3. Holding the left mouse button and dragging the mouse will move the selection
box accordingly.
4. After the selection box has been moved to the desired location, release the mouse
button. The content of the selected area will be moved to the new location. The
original content in the new location will be erased.
The second method is to use the copy, cut and paste functions. See next section.

5.2 Copy, Cut, Paste and Clear
Like most Windows software, you can copy, cut and past the selected content.
To copy or cut:
1. Select an area that you would like to copy or cut its contents.
2. For copy, click on the
icon or press Ctrl + C. For cut, click on the
icon or
press Ctrl + X. The selected content then will be copied or cut to the clipboard.
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To paste from clipboard, select a cell that will be the top-left corner for the to-be-pasted
contents, then click on the
icon from the toolbar, or press Ctrl + V.
After you have placed content into the clipboard, you can open a new music piece and
paste the content to the new music piece.
You can also only paste the dynamical mark, font or offset of the copied cell to the target
cell without change other contains of the target cell. These special paste functions can be
found under “Special Paste” menu item.
You can also paste the contents to another Window’s application, such as MS Word and
Excel. The contents pasted into other Windows applications will be high resolution
bitmap based images. You can even adjust the bitmap resolution using the “Copy to
Clipboard” quality parameter, which is specified in the preference menu.
If you would like to clear the contents of selected area, you can simply press the DEL key.
The content in the selected are will be cleared but will not copied to the clipboard.

5.3 Delete and Insert Lines
You can easily delete a line or insert a line into the music. To do so, choose menu item
Insert Line or Delete Line from the Edit menu. You can also use the short cut keys Ctrl +
INS and Ctrl + DEL.
When a line is deleted, all contents after this line will be moved up by one line. When a
line is inserted, all contents after this line will be moved down one line.

5.4 Delete and Insert Cells
You can easily delete cells or insert empty cells into the music. To do so, select a cell,
then choose menu item Insert Cell, a new empty cell will be inserted at this location. If
you choose Delete Cell from the Edit menu, the selected cell will be deleted. You can
also use the short cut keys Ctrl + I and Ctrl + D.
When a cell is deleted, all contents on the same line after this cell will be moved left one
cell. Empty cell will be appended to the end of the line. When an empty cell is inserted,
all contents on the same line after this cell will be moved right one cell. The content in
the last cell will be lost.
Note：You can also use DEL key to clear a cell, but it will not move the following cells
forward.

All Rights Reserved

- 38 -

Xiaoshu Xu

MusicWriter™ User’s Guide

Note:There is a menu item under Edit menu called “Apply Edit to Both Layer”. When
back layer exists and this item is checked, all edit function, such as copy, paste, move, etc
will apply to note on both layers. The back layer is explained in section 11.

5.5 Delete and Insert Measures
Delete Measure
You can delete a measure. First select the cell within the measure you would like to
delete. Then choose the menu item Delete Measure from the Edit menu, or use the short
cut key Shift + DEL. The measure will be deleted from the music and all measures after
it will be shifted up coordinately.
The delete measure can also apply to the full score music (the music with multiple parts.)
The delete measure works best if all the measures have the same number of cells. If you
have a cell which has significantly more cells then the previous measure, the software
may have trouble fitting all the objects in this measure to the previous one. In such a case,
the operation will stop here and the measure that has trouble continuing will be
highlighted with a yellow background color. You can manually resolve this conflict then
continue the “Delete measures” operation from where it stopped. This is an example:

This measure will be
deleted.

After pressing the Shift + DEL key, we have:
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The measure has
been deleted

But we have
conflicting.

We can now manually solve the conflicts by shrinking the notes in the long measure:

Conflicting solved and
this empty measure
needs to be deleted.

Then continue to delete the measures afterwards by pressing Shift + DEL again.
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Insert Measure
There is no direct function to insert a measure because when conflicts happen, as we
explained above, we may lose data. However, there is a way to insert a measure by using
the delete measure function. This is an example:

Where a new measurement
needs be inserted here

1. First, insert few empty ines after the line where the measure needs to be inserted so
that you have enough space to copy the line as described in the next step:

3. Then make a copy of the line that you would like a measure to be inserted:
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Copied line

3. The third step is to clear all objects in the duplicated measures so that it will look like
you have inserted multiple empty measures into the intended position:
Copied line with
duplicated
measure cleared

4. Now use the Shift + DEL key to delete unwanted empty measures until you get
the desired result:
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Delete Measure Options
As we have seen, when you delete a measure, the measures after it will be shifted up. In
many cases, you may like to shift not only the measures, but also the symbols and marks
above and below the line together. You can specify this option by choosing the Delete
Measure Setting from the Edit menu. This is the Delete Measure Setting dialog:

This dialog allows you to specify how many lines above and below the measures will be
shifted together with the measures.

5.6 Change the Size and Position
Change Size
All the notes, texts, images and some of the symbols can be resized. To do so, select the
object and click on the
icon (decreases the size) or
(increases the size). You can
also select an actual scale value from the pull down menu by clicking on the arrow beside
the icons. Click on the
icon can reset the size back to the default. As usual, there are
corresponding menu items that can do the same thing that are found under the Modify
menu.
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Even though you can resize the notes, if you have to resize many notes you may need
to change the cell size instead of using the resize option. The resize should only be
used in special occasions.
Move Position
You can move any objects up, down, left or right using
icons. Each click
shifts the object about 1/5 of the cell width. If you press Shift key while clicking on
those icons, it will only move 1/15 of the cell width. The icon will reset its position to
the default. You can also use the arrow key short cuts to move items, they are: CTRL +
UP, CTRL + DOWN, CTRL + LEFT and, CTRL + RIGHT arrow keys.
If an object is moved too much from its default position, it will not be easy for users to
know where its owner cell is. There is a menu item called “Show Owner Cell” under the
View menu. If this menu item is checked, a red arrow will be drawn from the shifted
object to its owner cell for the objects that has been moved too far.
Properties
Being able to change the size and position of objects gives the user great flexibility to
design music that looks right. The size and position of an object is called the property.
You can numerically change the object’s property using the property dialog. To do so,
select the object, click on the icon which will bring up the property dialog and you can
then change the values.

1 unit offset equals to 1/5 of the cell width. You can use float point number to precisely
control the movement.

5.7 Undo and Redo
Like most other Windows programs, you can always undo any editing you have done.
The
icon in the toolbar allows you to undo, or you can simply press Ctrl + Z for undo.
After undo, you can also to redo the undo by pressing Ctrl + Y or use the
toolbar.
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6. Shrink Notes, Vertical Notes and Grace Notes
6.1 Shrink Notes
In some cases there is not enough space in a measure to fit in all the notes. For example
you may have a lot of 16th or 32nd notes in one measure. In such cases you can shrink
these notes horizontally. To shrink a row of notes, you need do:
1. Select the row of notes you would like to shrink, it should contains at least two
notes.

2. Click on the
button in the toolbar, or choose menu text->Shrink Notes, or
simply press F10. The selected block will be shrunk to about the half the size in
the horizontal direction.

Note:
1. The shrink should only be done occasionally since it requires extra steps to edit the
shrunk notes (see 6.4). If you have to shrink too many notes, you may want to either
increase the size of each measure or you may even want to reduce the size of the cell.
2. To reduce possible editing in the future, make sure the notes have correct form before
shrink them, including the high/low dot, appended dot, underline, sharp, flat and
nature signs.

3. The shrink notes actually occupy only one cell, which is the first cell of the block
though it appears in more than one cell.
4. The shrink notes can only include notes (include append dot) and space.
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5. Once the notes is shrunken, it can be unshrinking if you select it and click on Shrink
icon again. The program will try to find enough space original space to hold these
unshrinking notes. However, if there is not enough space, it may cause some data to
be lost.
6. The default shrink rate is 65% relative to its original width. You can change the
amount of shrinkage. First select the shrink notes, then click on the arrow icon
beside the
button and choose Increase, Decrease, or Reset menu items.

7. You can also manually specify the shrink rate. To do so you select a shrink note then
choose “Enter Shrink Rate” in the drop down window. The popup window of enter
shrink rate look line:

Note: You can use same way to edit the compress rate of grace notes and vertical
notes which will be mentioned later.

6.2 Edit Shrink Notes
After a row of notes has been shrunk, it cannot be directly edited as normal notes. You
need to first let the system know which notes need to be edited since all notes occupy a
single cell.
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1. Select the shrink notes, you only need select the first cell, since shrink notes block
only occupies one cell which is the first cell (but it does not hurt anything by
selecting more than one cell).

2. Click on Ctrl + <number>. Here the number is the key 1 to 9, indicating which
note is about to be edited, for example Ctrl + 3 is for editing the third note
counting from bottom. If Ctrl + 0 is pressed, the edit will apply to all notes in this
shrink block. A text will show up in the status bar at the bottom of the window to
indicate which note will be edited.

After Ctrl + 2 is pressed, change will apply to 2 nd note

3. Then type the changes as you normally do. The keys that are valid in this case are:
numbers 0 to 7, comma (for low octaves dot), apostrophe (for high octaves dot),
period (for dot note), underline (for note length) and SPACE. You can also click
on the corresponding icons that change the underline, high dot or low dot. You
can also add or remove the sharp, flat or nature sign of the specified note. You can
replace the note with empty space but you cannot delete a note from the shrink
block. Of cause, you can always clear the shrunk block and redo it.

There is also another quick way to edit the individual shrink note:


Hold the Alt key while typing or clicking on the proper key/menu items will
modify the first note.



Hold the Alt + Ctrl keys while typing or clicking on the proper key/menu items
will modify the second note.
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Hold the Alt + Shift keys while typing or clicking on the proper key/menu items
will modify the third note.



Hold the Alt +Ctrl + Shift keys while typing or clicking on the proper key/menu
items will modify the fourth note.



The “_” key will not work with this key combination since you have to hold the
shift key to type the “_” which will cause a conflict.

You can edit vertical notes (cords) and grace notes mentioned below in similar way.

6.3 Create Grace Notes
You can create a pre and post grace notes similar to the shrink notes:
1. Create the notes in the normal way. Make sure they are in the correct form;
include their underline, high/low dot, appended dot, sharp, flat and nature signs.
For example:

or

2. Select the entire block, then click on the
icon (for pre- grace) or
(for postgrace) from the toolbar (You can also use menu items “Pre Grace Notes” and
“Post Grace Notes” from the Text menu.) The selected block will change to the
proper grace notes, e.g.:

or

3. Like shrink notes, the grace notes also occupies one cell which is the first cell of
its original notes. You can still modify and unpack the grace notes similar to the
shrink notes. See Section 6.2 “Edit shrunk notes”. Grace note is about 35%
smaller than normal note. Like the shrink note, the compress rate of grace note
can be adjusted as well, see section 6.1.
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6.4 Create Vertical Notes
Vertical notes are blocks of notes listed vertically. For example:

Most of the time, vertical notes are used to present the chord notes. Sometimes it can
also to be used to presents multiple part of the musical instruments. For example, the top
notes for Erhu 1 and bottom notes for Erhu 2.
You can certainly create the vertical notes by typing them separately in adjacent cell like:

But not only will this make it look too tall, but also the notes are not recognized as a
group of notes and will not convert correctly when we try to convert the music to the
western notation, or break the music into multiple parts, or when you play the music.
The best way to make a chord notes is to create a vertical note block.
Similar to shrink or grace notes, to create vertical notes, you first type the notes in a row
that you want to be part of the vertical notes block. Make sure they are in correct form,
including high-low dot, appended dot, sharp, flat and nature signs, etc. Then select the
block and click on the
icon, or select the menu item Vertical Notes from the Text
menu, or simply press F9.

The system will make sure that the upper note is always higher than the lower note during
the process. For example, if you type 531, it will convert to 5, 3 with one high dot, and 1
with 2 high dots:
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Like shrink notes, the vertical notes will occupy one cell which is the bottom cell of the
vertical note. You can modify and unpacked the vertical notes similarly to the
shrinknotes. See “How to edit shrunk notes”. The only exception is the underline. You
can not specify the underline for individual notes. The underline for the vertical notes
only applies to the entire block. You can edit the underline like a normal note.
Another quick way to create vertical notes is to use short cut key “Z”. selecting a note
and press key “X” will add a note above current note. The added note is default to 2
degree higher then note below.

Press key “Z”
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6.5 Use Pre-Defined Chord
There are several predefined chords to choose, which all defined in the dynamic mark
window. To select a predefined chord:
1. Enter the root note of 1, 2, 3, 5, or 6 with proper high or low octave dot.
2. Select the cell and click on the button (for 3 note chord),
or
(for 7 note chord) from the Dynamic Mark window.

(for 4 node chord),

This is a 4 note chord example:

If you want to add a arpeggio symbol on the left side of the chord, choose
, , or
button instead. The following is a 3 note chord example with arpeggio symbol:
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7 Files and Print
7.1 Create New Files
To create an empty file, you can choose New from File menu or click icon
Bar.

on Tool

7.2 Save, Load and Share Music Files
Using Save or Save As from File menu, the music can be saved as a MusicWriter file that
has extension “mus”. Though you can use other letters for the file extension, we strongly
suggest you stay with the default extension.
After the file is saved, it can be loaded back to the MusicWriter using the Load menu
item from the File menu.
The MUS file is a self efficient file (except for large images). That means you can share
the MUS file with other people who have MusicWriter by sending them the MUS file.
There are few notations:


Depending on how the default fonts are setup on the computer, the MUS file
loaded may look different from its original font when it was created. This can be
an advantage. For example, one can create the music in Traditional Chinese.
Another person can open it in simplified Chinese without make any changes.



If the music contains image that has size less than 1 mega byte, the MUS file will
save the image data along with other information. For image larger then 1M the
actual images are not contained in the MUS file, only a point is in the MUS file
that points to the location of the image. In such case, you also need to share the
image files.

7.3 Browser Music Files
The Browse function in File menu allows you to browse a directory and list all music
files by its title, file name and number of pages. This function helps user to easily locate
the correct music piece to open.
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Determination of Music Title
The title of a music piece is determined by the following rule: The first text string
within the first 10 lines of the music that contains at least 1 Chinese character, or 5
English characters. If a title string cannot be found, the file name will be used as the
title. For this reason, one should always put the title text as the first text in the music.

7.4 Print Music Files
To print current music, choose Print from File Menu. The print dialog will open like:
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You have several options to choose and all are self-explanatory.

7.5 Save Music to Image File
You can also save the music as an image file. You can save as either a JPEG or BMP file
format. The JPEG is preferred since it is a compressed format and will take less disk
space than BMP. You can use image files to share music with others who do not have
the MusicWriter software.
To create the image file, choose “Save to Image File” menu item from the File menu, the
Save to Image File dialog will pop up.
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You need specify image file width. Larger the width is the bigger the file and better the
resolution will be. If the image width is too large, the computer may not have enough
memory to create the file and in such a case an error window will pop up to ask you to
reduce the image width. In general, the up limit of BMP file is larger than JPEG file.
Therefore if the width of a JPEG file is too larger, you can try to change to BMP format.
Based on author’s experience, the max width is about 3000 pixels for JEPG file and 8000
pixels for BMP file.
For BMP format, there are two types of color schemes: Black/White or Color. The
Black/White image will take much less space than the color image. For JPEG file, you
can choose Gray Scale or Color. There is no difference in file size.
If the music has more than one page, there will be multiple image files created, one for
each page. The image file names in such case will be the file name that the user specified
appended with “_N”, the N is the page number.
Note: Since JEPG is a compressed file format and take much less disk space so author
recommends using JPEG file format.

7.6 Save Music to MIDI File
You can save the music file to a MIDI format file. You can use any third party player
that compatible with MIDI format to play this music.
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8. Preference
The preference dialog allows user to set up several key parameters. To open the
Preference dialog, choose Preference from Help menu. All parameters in this dialog are
persistent, that means they will not change its value even you reenter the program.

8.1 Appearance
Paper Size and Orientation
The MusicWriter is designed to fit any size of paper. You can either select a pre-defined
paper size, or directly enter the paper size in inches. You can also choose to lay the paper
in portrait and landscape.
Note: The paper size is always defined in either mm or inches, 1 inch = 25.4mm.
Cell Size and Margins
You can set up cell width and margins in the Preference. The cell height is automatically
set to twice the width. Cell width and margins are all defined in pixels.
This software uses an internal unit called “pixel”. The standard letter paper (8.5 inch in
width) will always set to 1000 pixel wide. Therefore each pixel is about 0.0085 inches,
or 0.216 mm. The user should use the Preference dialog to set up the cell width
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accordantly. All other sizes, such as the size for notes, texts, symbols and marks will be
automatically adjusted based on the cell width. For example, if we set the unit width to
20 pixels, then the actual unit size when printed is about 4.3x8.6mm. For your
convenience, system also show the corresponding size beside the pixel unit.
Note: The pixel used in this software design is deferent from the pixel of we normally use
for the display device. The pixel we used is directly corresponding to the print size while
the pixel at display device cannot.

If there is music opened and the paper size, orientation, cell width or margin is changed,
the music will be adjusted to fit the new size. In such case, some of the information on
the music may be lost if the number of cells per row or per column decreased. If the
number of cells per row or per column increased, you may need to rearrange the position
of the data to fill the extra spaces. Anyway, we strongly suggest that you set these
parameter properly based on your preference before enter any data.
MUS file includes the paper size, orientation, cell width and margins that are used to
create this file. Therefore when you open a file, it may be created using different
parameters and these parameters will be used for this file no matter what is set in your
local computer. This does not mean the default values of these parameters have been
changed. If you create a new file, the default parameter will still be used.

8.2 Font Setup
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Default Font Setup
There are three default fonts: one for the notes, one for the English texts and one for the
Chinese texts.
If you check the “Use Chinese Version”, the software will display almost all interface
texts in Chinese, such as the menu, dialogs, etc. You can also uses the short cut key F7 to
quickly switch between Chinese and English version. See section 2.5 for details.
Please note that if you are running English version of Windows OS, you need to setup
your environment correctly in order to run Chinese version. Please see document “How
to Setup Chinese for MusicWriter.doc” for details. If you are running Chinese version
Windows OS, you should be able to run the software in Chinese without additional work.
The following is a screen shot when the software is running in Chinese:

On this page, you can also set up the “Copy to Clipboard” quality. MusicWriter uses
standard Windows Clipboard to store the copied image in a bitmap format so you can
paste it to other Windows application. Higher the quality is, higher the bitmap resolution
will be used. However, if the resolution is too high, you may not have enough memory in
the clipboard to store the image.
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8.3 Printing and Other Misc. Settings

In the Printing & Misc. page, you can set other options:


Print Size Adjust – Sometimes a printer is slightly different in terms of its printed
text size, the Print Size Adjust is a percentage of the adjustment of the note font
when printed. If you see a font size difference between the printed copy and the
viewing on screen and dissatisfied with the printed result, adjust this value.



Print Line Width – again, due to the difference between printers, the line
thickness (such as the under line, dash，point, etc) may look too thin or too thick
on the printed copy. Adjust this value to achieve desired line thickness.



Footnote Text Font Size – There are optional footnote on the print page that can
show the music title, book title, and file name. This parameter determines the
size of the footnote text.



Default File Directory – Where you commonly store your music files.



Default Image Directory – Where you commonly store your image files.
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8.4 Color

In this page, you can reset various color options.
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9. Tools
9.1 Shift Notes
You can easily shift the note by one step or by a whole octave. First select the notes that
you want to shift, then use Shift menu item in the Tool menu. There are short cut keys as
well. Shift + F8 shifts them whole octave higher. Ctrl + F8 shifts them whole octave
lower. Shift + F1 shifts them one step higher. Ctrl + F1 shifts them one step lower. For
example:

After shift one octave higher, it becomes:

After shift one step lower, it becomes:

9.2 Add Measure Count
The measure count can be added automatically. Selecting Tool -> Measure Count will
pop up the Add Measure Count dialog:
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The first group in the dialog window allows you to specify how often the measure count
will be added. The second group of parameter allows you to specify where to start and
the start number. The Position Offset is an offset in pixels that the measure count text
will be displayed. Using a negative offset will allow the measure count text slightly
above the bar line so it will look better. Finally you specify if the measure count will be
added to this page only or to all following pages.
When measure count is added, any old measure count, if exists, will be removed.
This is an example of a music piece that has measure count added:
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Add new time signature to where it changes:

9.4 Auto Underline
Underlining all notes correctly can be a lot of work when you create the music. This is a
tool that can save you a lot of time.
To execute the Auto Underline, you first select a block of cells, and then either choose
Tool->Auto Underline, or simply press the F11 key. If you only have one cell selected,
the Auto Underline will apply to the entire row, otherwise it will apply to the selected
area.
The Auto Underline algorithm uses the following rules. So in order for Auto Underline
to work right, you need follow these rules as close as possible:
1. If 8 or more notes are grouped together without space in between, it will add triple
underline to them (so assume they are 32nd notes).
2. If 4 or more notes are grouped together without space in between, it will add
double underline to them (so assume they are 16th notes).
3. If two notes are grouped together, it will add a single underline to them (so
assume they are 8th notes).
4. If three notes are grouped together, it will add single underline to the first note
and double underline to the second and third notes.
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5. If an appended dot exists, it will add an additional underline to the following note
to reduce its time value by half.
This is a line of music before the Auto Underline applied:

This is the result after Auto Underline:

The Auto Underline can do most of the job for you if you follow the rules. However, you
still need to verify the result after Auto Underline to make sure it is correct. The rule
number 4 needs a special attention because when 3 notes are together, it can mean
or , for example. You may need to fix it manually. But there is an
icon on the
left bar that will allow you to switch between these two variations by a simply click.
Software will highlight these notes for you to examine.

9.5 Break Full Score Music to Parts
To break a full score music into individual parts (分谱), select Break Down menu item
from the Tool menu. A dialog will pop up as shown below.
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First you need to specify which rule to use to identify the music line of the part you
would like to extract. There are 4 different types of rules:
1. By Line Count – Use the line count number to specify the music part. In the
following example, 笛子 will have line count of 1. 二胡 will have the line count of 5.

2. By Instrument Name – If you have the instrument name at the beginning of every line,
you can also use the instrument name to identify the music part. In the above
example, you can use text 二胡 to identify the music part for 二胡.
3. By Bracket Count – Since full score music will have the bracket or brace at the
beginning of the line to group the music parts, you can also use the bracket (or brace)
count to identify the music part. For the above example, the bracket count 1
represents the music line for 笛子. Bracket count 5 represents the music line for 打击.
The bracket count 3 will represents music line for 二胡 and 中胡.
4. By Highlighted Lines – You can manually highlight individual lines and ask the
software to extract these lines of music for you. To highlight a line, you need click
on the margin area of the line (like you select the whole line) while hold the Alt Key.
If the line is already highlighted, it will clear the highlight. The following example
highlights the 笛子 and 打击 parts:
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After selecting the rule to use, you then need to enter the parts to be extracted in the edit
box. If you like to extract multiple parts, you need to enter the indicators in comma
delimitated format. For example, if you choose the Line Count rule, and like to extract
music for 二胡 and 中胡, you need enter “5, 6” in the edit box.
Finally, you need select which additional lines to be included. Remember the top line
may contain the useful information such as the section name, measure count, etc that you
may want to keep.
The following example is the result of Break Down for 笛子 and 古筝. We have
included 1 top line, 1 line above and 1 line below:
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As you have seen, though the Break Down has done much of the work for you, you may
still need to do some clean up to make the part music perfect.

9.6 Add Bow Direction
The software can add bow direction symbol automatically for string instruments. To add
bow direction, you need to follow the following steps:
1. Make sure all the slur marks are correct for your music.
2. Select a cell where you want to start. The selected cell must be on a music line.

3. Select Bow Direction menu item from the Tool menu. The add Bow Direction
dialog will pop up:

All Rights Reserved

- 68 -

Xiaoshu Xu

MusicWriter™ User’s Guide

After specifying all options, click on the “Add” button. All existing bow movement
symbols will be cleared and the new bow movement symbols will be added.
All options on the dialog are self-explanatory except the dropdown box “Find Music Line
By”. This option specifies the rule that is used to find music line when dealing with full
score music. See section 9.5 “Break Full Score Music to Part” for details.
If you click on the Clear button, it will only clear the existing bow movement symbols
without adding new ones from where it starts.
Clicking on the “Reverse” button will reverse all existing bow movement symbols from
where it starts.
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10. Create Western Notation Music
Though the MusicWriter program is designed for Simplified Notation, it contains all the
abilities to create the Western notation music. You can use the functions described in this
chapter to edit the music that is converted from Simplified Notation, or create a music
piece completely from scratch in the western notation. Following is an example from
Beethoven Piano concert No. 3 created by MusicWriter:

All Rights Reserved

- 70 -

Xiaoshu Xu

MusicWriter™ User’s Guide

10.1 Create Staff
1. Select a block of cells, usually a single row of cells.

Note: Though it is perfectly fine to mix the simplified and western notation on the same
piece, it is not a good idea to have western and simplified notation on the same roll.
2. Choose Create Staff menu item from Western menu, a dialog will pop up asking
you to select a clef. You can select G, F, C3 or C4 staff. The Other Staffs page
includ
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3. After selecting a desired clef, click on Ok, the specified staff will be created.
This is an example of D Major G staff:

This is an example of percussion staff:

If you want to create a grand staff, you can first create a G staff, then select “Convert
to Grand Staff” menu item from the Western menu:

Use “Convert
to Grand Staff”

The staff created use this method will be always default to G-F staff combination. If
you want the first staff to be F or second staff to be G, you can always change it by
selecting it and use “Change Staff” or “Create Staff” menu item.
If there are note on the G staff before you convert them into grand staff using this
method, the program will move the “low notes” (now notes here means lows on or
below second low adding line) to the F staff. See example below:
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Use “Combine two
to Grand staff”

Another way is to manual create two staffs, then select “Combine two to Grand staff”
under Western menu.

Use “Combine two
to Grand staff”.
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In second method, you can combine any two existing staffs to form grand staff. The
music notes if exist will have no changes.
Of cause you can always connect two staffs with the brace to form grand staff but in
such case the program will not recognize tit as a grand staff and this may cause issues
when you play the music or perform other functions later.

Note: After you create a designed staff, you can use copy/paste method to create multiple
empty music sheet for use in later.

You can add measure bars and repeat bars just like you do in simplified notation: select
the cells and click on the icon on left bar or press the “|” key.

After you setup a staff, you can easily switch between G, F, C3 and C4 staff with its
notes. To do so you just need to select “Change Staff” in “Western” menu. All notes in
the staff will also change their position coordinately. See example below:

If you have a staff that changes the clef or key in the middle of the row, you can insert a
new staff in any position of the row. To do so just simply select a single cell where the
staff change needs to be, and then use “Create Staff” function; a new staff will be added
in the position. Normally the clef is smaller in this case, you can use
icon on toolbar
to reduce it size. You can use staff option explained next to remove the clef sign (if only
key is changed) or key signature (if only clef is changed). This is an example:
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As we said above, usually if clef is changed but key signature is not, then the clef do not
need to shown. Same as if key signature is changed but clef stays same, the clef do not
need to shown. We can use staff option to achieve this kind of format. Under Western
menu you will find a submenu called “Staff Option”.

:


Hide Clef Sign:



Hide Key Signature:
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Hide Start Line:



Hide End Line:



Set as Comment Staff: In some cases the music needs to have comments. The
comments could be a different way to play the music, Normally the comment staff
are smaller in size comparing with normal staff.

Comment Staff

We explain how to use staff option to setup a comment staff in below:
Step 1: Create a normal staff, the position and length of the staff is depending on
your needs.

All Rights Reserved

- 76 -

Xiaoshu Xu

MusicWriter™ User’s Guide

Step 2: Based on situation, you can hide clef, key signature, start and end line.

Step 3: Create desired music.

Step 4: Set the staff option as a Comment Staff.

You can edit the notes in comment staff just like in normal staff.

10.2 Enter Music Notes
There are several ways to enter the western notes.
Method 1 - Use the icons on the Western Notation float window. To make the floating
window appear, click
icon from Toolbar, or select Western Notation menu item from
Windows menu. See below:
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1. Select the cell or cells on the staff.
2. Clicking on icon
will allow you add the proper rest notes.
Just select the cell and click on the proper icon. The rest notes will be place on
the required location. They all have shortcut key ([, ], s, h, j, k, etc.).
3. Clicking on icon
will allow you to add the music notes
with various time durations. They all have shortcut key (q, w, r, t, u, o, etc.). The
note will be added to the default location (on the center line). This is an example:

The notes entered using this method will have the correct tail (time duration) but not
on the correct position. You need to click on the
icons or press UP or DOWN
arrow keys to move it up or down. There will be other method that we will discuss
later to change their position. Many of the buttons on the float window will have a
key shortcut. For example the 4th note button has shortcut key “r”. You can press
key “r” to add the 4th note. To see the shortcut key, simply move the mouse cursor to
the button and you will see a popup hint window revealing the shortcut key. If you
can memorize the shortcut key, using the shortcut key can speed up your data entry a
lot.
Method 2 - Use the Western Notation Letters. Western music notes are denoted as C, D,
E, F, G, A and B. For example, to add a C note, you can press the key “C” or “c”. The
uppercase “C” will be 1 octave lower then lowercase “c”. You also can use “,” and “’”
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key to lower or raise the added note octave lower or higher like you do in simplified
notation. For example, press key “,” first then press key “c” will make the added note 1
octave lower (equivalent to press key “C”). You can even use multiple “,” or “’”.
Method 3 - Use the Simplified Notation Numbers. The simplified music notes are
denoted as 1, 2, 3, 4, 5, 6, and 7. It can be transfer into A, B, C, D, E and F based on the
current clef. For example, to add a note 4, you can press the key “4”. If current clef is C
clef, that will add a note F. Just like in simplified music, you can use “’” or “,” key to
make the note 1 octave higher or lower. For example, press key “,” first then press key 4
will make the note added 1 octave lower. You can even use multiple “,” or “’”.
The “,” and “’” key can also used to modify the existing notes. For example, press “,”
key will make the selected notes 1 octave lower.
The note create using method 2 or 3 will have correct position but they are default to 4th
notes. You can change the default duration by press F1 key. You can use the same
method like in simplified notation to change it. For example, type underline (_) will
change 4th note to 8th note. Press dash (-) key will change 4th note to 2nd note, etc. You
also can use either the buttons on the floating window or the shortcuts that have been
discussed in method 1 to change its tail (time duration). For example, after select a note,
press the icon
on the Western Notation floating window, or simply using the shortcut
key “y”, the notes will change to 16th note (the position of the note will stay the same).
You can also use the “Auto Underline” tool (see section 9.4) to add the tails
automatically for you if you following the rules described in Section 9.4.
Method 2 will make creating western note almost the same as in simplified notation
system.
Pressing F1 key can change the default note time duration. Press once it will default
to 1/8 note, then to 1/16 note, then back to 1/4 note. Combine F1 and method 3 can
quickly create a music sheet.

10.3 Edit Music Notes
Move Notes Position. First select the note or notes to be moved.
1. To use western notation position, such as G and g, press key “G” or g. If this is a
cord, it will only move the root note to the specified location. Other notes in the
cord will adjust accordantly.
2. To move to simplified notation position, such as 3, press key 3. The actually
location will be determined based on current clef. This method only works for
single note, not cord.
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3. To move the note 1 octave higher, press the key “’”. Use key “,” to move it 1
octave lower.
4. You can also use the up and down arrow keys to move them up and down.
5. You can always use button
corresponding menu items.

to move them higher or lower. Or you can use

This is an example:

You cannot move the notes that are on the percussion staff。 See following example:

There are other editing functions on the floating window.
1. The icon

or shortcut key “\” will flip the tail of the selected notes.

2. The icon
or shortcut key “z” will add additional notes to the existing note to
create cords.

A cord can have two or more notes. After a cord note is added, you can use the
press UP or DOWN arrow keys to move it. You can also use the icon
on
the tool bar.
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You can also use vertical icon in tool bar to create cord like in simplified notation.
To do so, just types the cord in continues cells, then selects all of them and click on
the icon in toolbar, see below.

3. To move a specific note in the cord up or down, first select the note, then press a
number key 1 to 9. 1 means move the root (lowest) note, 2 means move the
second note, and so on. Then click on the
icons or press UP or DOWN
arrow keys to move the specified note up or down. When a number key is
pressed on a cord note, a text will show up in the status bar at the bottom of the
window to indicate which note will be edited (see below). If no number key is
pressed, the root note will be moved. There are also three quick keys without
press a number key first: holding SHIFT + UP or SHIFT + DOWN arrow key to
move the top (highest) note; holding CTRL + UP or CTRL + DOWN key to move
the root (lowest) note. Holding CTRL + SHIFT + UP or CTRL + SHIFT +
DOWN keys to move the next to the top (second highest) note.
After number 2 key is pressed,
the status bar shows the change
will apply to 2nd note

All Rights Reserved

- 81 -

Xiaoshu Xu

MusicWriter™ User’s Guide

4. The
icon or shortcut key “x” will delete an individual note from a cord. By
default, the lowest (root) note will be deleted (key “X” will remove highest note).
However, if you press number 1 – 9 before clicking on this icon, the
corresponding note will be deleted. For example, to delete the second note from
the root note, press 2 first then click on this icon.
5. Icon
or shortcut key “m” will connect the tails of the selected notes. For
example:

You can also connect the tails of notes that cross the G and F staff. For example:

To do so, the notes on the G staff need to have their stem downward and notes on
the F staff need to have their stem upward. The following are more examples:

6. Icon

or shortcut key “/” will disconnect the tails of the selected notes.
or shortcut key “.” will add appended dots to the selected notes.

7. Icons
8. Icon

will add staccato dots to the selected notes.
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9. Icons
will add one or multiple short bars on the stem of the selected notes.
See below:

10. Icon
will move lower note from G staff to F staff, or higher note from F staff to
G staff:

11. Icon
connects stems of two notes that cross G and F staffs. The stems of two
notes need to have the same direction.
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12. Icon

will show or hide the corresponding letter of the note:

13. Icon

will hide the stem of the selected notes.

14. Icon

will hide the head of the selected notes

13 and 14 can be used to create some special music notations. These are some examples:
The first group of notes is a cord without stem. It is constructed by removing its stem.
The second group of notes is created using back page that will be explained later. You
can also use the following method:


Create the half note and 4 16th notes normally:

Note: A better way to create such note is to use back layer. See section 11.2 for detail.
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Remove the head of the first 16th note:



Shift the half note position right (you may need to hold Shift key for fine
adjustment). For better control, zoom in the view:

NOTE: The note created on this way will not play right or convert right. A better
way is to use back layer to create such note. See next section.
The third group of notes is created using the following method:


Create 5 16th notes normally:



Remove the head and stem of the last 16th note:

15. Icon
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Finally there are two Up/Down buttons

on the float menu.

Extend or
shorten the
tail

changing the
horizontal
position of sharp,
nature or flat
symbol

The one on the second row is for extend or shorten the tail:

If multiple tails connected, you only need to change the tail length of first or last
notes. The rest notes will adjust accordantly. In following example the first note rail is
changed longer.
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The Up/Down icon on the 7th row is for changing the horizontal position of sharp,
nature or flat symbol:

Note: The owner cell of any western music note is the cell on the staff although the
note itself may be shifted up or down outside the staff. Therefore to select the music
note, you must select the cell on the staff line, which is not necessarily the cell that the
note appears to be. See the following example:

The owner cell
of the note

Besides the icons in the Western Notation window explained above, many icons in the
Left Toolbar (see section 2.4) also can be used to work with western notes. For example,
can make the note being a 8th note, can reduce the note 8 steps,
sign to the note,
will add adot to the note, ect.

will add sharp

10.4 Symbols and Dynamitic Marks
Many symbols and dynamic marks used in Simplified notation can also be used in
Western notation. For example, you can add sharp, flat or nature sign to the notes just
like in the simplified notes. You can also add slur to connect two or more notes, or add
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piano paddle marks. Please refer to the sections in chapter 3 for details. The following is
an example:

Besides
mark, a music piece sometimes also uses lines under a music line to
makethe paddle. See below:
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In this program, we use the square line

in Dynamic Mark window to mark

the paddle lines, see section 3.4. After you add a square line, you need to use
to flip
the line to make itr square ending upwards. If two square lines connect each other, the
square heads at the connecting ending will tilt outward to form desired shape as you see
in above example.

10.5 Slur Marks
Even though most of dynamitic symbols in western notation are the same as in Simplified
notation, the slur is a exception. Unlike the slur in Simplified notation, which is always
laying horizontally, the slur in western note is tied along the notes. See this example:

Normally, you add slur in western notation just like you do in simplified notation, that is
select group of notes that you like to connect with slur, then press “ ” button in the
Dynamic Mark window. However, there are some special cases we need to point out:
1．Please note that the owner cells are always on the staff lines though the notes
themselves may shifted outside the staff. See following example:

If needed, you can use the dynamic edit buttons to adjust the shape of the slur.
2．Use

to switch the direction of the slur.
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3．Sometimes in grand staff the slur can cross G and F staff. You can use the
dynamic edit buttons to make this happen:
a. First setup a slur on the G or F staff, make sure the slur has enough length to
cover the entire notes (on both G and F staff) that you like to be connected.

b. Using

c. The using

和

to move the tail end of the slur to the desired position.

to change the slur curve to a desired shape.

4．Multiple slurs on the cords.

All Rights Reserved

- 90 -

Xiaoshu Xu

MusicWriter™ User’s Guide

a. Create a single slur as you normally do：

b. Using an empty cell above the staff to create a independent slur with desired
length:

c. Then using
，
，
to adjust it to the desired location and shape
Similar techniques can be used if more than 2 slurs are used.

10.6 Shrink and Grace Notes in West Music
You can use icon
in toolbar to shrink and grace notes just like in the simplified
music, see section 6. Please note that even though you can simply make the notes smaller
to make it looks like a grace note, but you should always use icon on tool bar
otherwise other functions, such as play or conversion may not work correct.
Combine shrink and resize icon, you can make continues long music notes. See
following example:
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11. Main Layer and Back Layer
11.1 What is the Layer?
The MusicWriter actually have two layers, the main layer and the back layer. The main
layer is the default layer and in most of time, you can do all things you needed in main
layer. But occasionally, you may not have enough spaces in main layer. Switch to back
layer will give you great flexibility to do what you want.
You can think that the back layer is another entire page that is transparently overlay on
top of current page. All the notes, symbols, and others on the back layer will be
overlapped with the main layer and will be printed just like the ones that are on the main
layer. However, you can only edit one layer, called active layer, at a time. The staff on
the inactive layer will be displayed in gray, while the staff in active layer will be
displayed in black (if the main layer is active) or dark green (if the over layer is active).

Notes in
inactive
layer

Notes in
active layer
(main layer)
Even though the notes on different layer are displayed in different color, when the music
is printed or copied to the clipboard, they all use the black color.

11.2 Use Back Layer
To switch between back layer and main layer, click on the icon on tool bar, or choose
menu item “Switch Layer” under View menu. This is the same example above but
viewing in back layer:
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You edit the back layer just like you do on the main layer. However, you should only use
the back layer as a supplementary data area. One very good example is to use back layer
to create multiple parts of the music on western notation that shares the same staff, as the
example we see above.
Using back layer will let you have great flexibility when create music piece. For example,
to create a sample note mentioned in section 10.3, we can do:

In this example, the half note is created in the back layer.

11.3 Customize the Layer Color
All layer’s color, and background colors used in the software can be customized in the
“Preference” window, see below:
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12. Converting Between Simplified and Western Notation
12.1 Convert from Simplified to Western
You can convert music from Simplified notation to western notation:
1. Select Simplified to Western menu item from Western menu. You can choose either
convert only the selected area, or from the current selected position to the end.
2. If your music piece has a tone signal, such as 1=G, then the staff will be automatically
determined. Otherwise a dialog box will pop up to allow you to choose the proper staff
for the western notation.

3. After a proper staff is determined, the music will convert to western style.
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The following is an example.

Music in simplified notation:

The same music piece after it converted to Western notation:

Since the first cell is always used for the staff signature, you should not have a note in the
first cell. In such case a warning message will show up.
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The shrink and grace notes will also be converted correctly as shrink and grace notes.
The vertical (core) notes also will be converted correctly.
If there are errors during conversion, the cells that contain the errors will be highlighted
after the conversion. If there are simplified notes left, that also indicates possible errors.
However sometimes the error may not be detected by the software and therefore will not
always be highlighted. You need to always examine the result carefully after conversion
and manually fix any errors.
You can also convert full score music. See the following example:
The music in Simplified notation:
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After it convert to Western music, it will looks like:
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You can see example few incorrect place, it did almost all the conversion for you.
This is another example:

The same music converted to Western notation:
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In the above example, you can see that even percussion instruments have been converted
accordantly. You can also see the place where one note has been lost because they were
shrink notes. The problem cell has been highlighted in yellow. You must manually fix
these errors. You may also edit the music to make it looks better.

12.2 Change Western Staff
During conversion the system will determine the correct staff for you. In above example,
the Base part is determined to use F staff instead of G staff. But in some cases, you may
want to change the staff. You can easily do this using the menu item Change Staff from
Western menu:
1. Select the row that its staff needs to change.
2. Choose menu item Change Staff from Western menu, there will be 4 submenu
items can be used. Using them you can change the currently selected staff to G, F,
C, or percussion staff.
The following is the result of converting G staff to C3 staff for the “中胡” part.
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12.3 Convert from Western to Simplified
You can convert from Western notation back to Simplified notation by using the Western
to Simplified menu item from the Western menu. The following is an example of
converting the same piece above back to Simplified. You can clearly see the missing
notes due to the shrinkage. If any possible error is detected during the conversion, the
corresponding cells will be highlighted. Also if you see any western notes left, that will
indicate a possible error area. Again, you must manual fix these errors.

The following example is to converting the same music above back to simplified one:
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Another example of Western music sheet converting to Simplified piece, this time it is a
piano piece:

All Rights Reserved

- 103 -

Xiaoshu Xu

MusicWriter™ User’s Guide

After it covert to Simplified music:
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Please notice that on the last line, there are extra notes on top of the music
line that are shown in gray color. If you comparing the original Western
music, you will see there are notes in “Back Layer”. We explained the back
layer concept in section 11. Since simplified music notation cannot handle
back layer note easily, we simply put them on top of the music line.
12.4 Convert G Staff to Ground (G + F) Staff
As we have seen, you can easily switch between G and F staffs. However some
instruments, such as the 古筝 or piano, cover a great range of spans that a single staff
many not quite fit the music when converting from Simplified to Western. We have a
tool that can change the G staff to Grand staff (G+F staff). Considering the following
example:

When it converts to Western using G staff, it becomes:
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Now using menu item Convert G to GF Staff in Western menu, it will be converted to
grand staff:
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13. Create Music Book
Music Book allows you to organize the music by books. Clicking on the icon
from
toolbar or choosing Book from the Tool menu will pop up the Music Book dialog:

13.1 Add and Remove Music in the Book
To add music to the book, click on the
icon, a file selection window will pop up
allowing you to select one or more music files (MUS files) to add. The music will
always add at the bottom of the music list. You can change the order using the up and
down arrow icons, see next section.
After music is added, the dialog will look like:
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All the music contained in the book will be listed in the table. The table lists the title of
the music, file location, start page of the music in the book and number of pages of the
music.

13.2 Edit the Book
In Music Book dialog, there are several ways to edit the book contents.
1. Delete Music – You can delete any music by selecting that row and click on the
icon or simply press the DEL key
.
2. Change the Order of the Music List – you can change the order of the music.
Select the row then click on the or
icons will allow you move that row up
or down.
3. Change Music Title – We have discussed how to decide default music title for the
music in section 7.3. You can change the default title to any other text by either
double clicking on the music title or selecting the music and click on the
icon.
A text edit dialog will pop up to allow you enter English or Chinese.
4. Change Music Location – The music location can also be changed. Simply
double click on the music location or click on the icon, a file selection dialog
will pop up to allow you to specify the new location for this music.
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5. Add Book Title – The book title can be used to identify this book. It also can be
seen in the footnote of the print copies. Pressing the Edit button will allow you to
enter the book title in either English or Chinese.
6. Add Title Page – Title page is no more than a single page music file. It can
contain any object, such as music title, publication information or images. The
title page, if included, will be the first page of the printed copy.
7. Open the Music – You can open the selected music by clicking on the
double clicking on the “Start At” column.

icon or

13.3 Save, Open and Create New Book
Click on the icon
on the Music Book dialog will create a new book. After a book has
been created, you can save the book and load it back later. To save it, click on the
icon for Save or
for Save As. A saved file dialog will pop up allowing you to enter a
file name. The music book file always has extension mbk.
To load a pre-saved book, click on the
icon, then select the book file to open.
Clicking on the down arrow will allow you select up to 5 recent books from the pull
down list.
The book file will only save the pointers to the location of each music file it contains, not
the music file itself. So if the specified music file does not exist, it will display the text of
that file location of the music in red. If you do not manually relocate the file, it will be
ignored when you print the book.

13.4 Print Book
Clicking on the
book.

icon will pop up the Print Book Wizard that allows you to print the
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On the first page of the wizard, you can select various options, such as one side or two
side print. If it is one side print, you can also choose to print front, back, or both side.
This will allow you to emulate the two side print by print the front page first, then flip the
papers in the printer and print the back pages on the pack of the paper.
If you choose to include a table of contents, the table of contents will be automatically
generated and printed after the title page (if title page is included).
You can also choose to include the title on the footer of the page and file name on the top
of the page.

On the second page, you can specify which pages to be printed and then press Print to
execute.
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14. Play Music
14.1 Play Music Window
You can play the music using “Play Music” floating window. The window looks like:

At top of the window, there are three buttons:
Play button – Click on this button will start play currently open music, starting from
current selected cell.
List button – Select multiple pieces from a folder to play.
Stop button – Stop play when clicked
Next button – When play list, stop play current piece and start next piece.
Next, there are two radio buttons: Simplified and Western. In most of cases, the system
will automatically select correct one for you based on current music. The only time you
need to manually specify it is when a piece contains both western and simplified music.
The following combo box allows you to select which portion of the music should be
played. There are five choices:
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Whole (Score) Staff – All music will be played exactly as it is written. If the
music is a score staff, or a grand staff, all sub-staffs will be played together.
This choice will be used in most of time and is the default choice.



Current Staff – Only current staff will be played. For example you can play only
left hand staff of a piano piece by first put a mouse on the hand staff and choice
this option.



Current Staff Group – The current staff group will be played. For example you
can play only the string instrument group of a concert piece.



Current Staff Group – The current staff group will be played. For example you
can play only the string instrument group of a concert piece.



Highlighted Staff – Only highlighted staff/music line will be played. See
section 9.5 on how to highlight a staff/music line.



Selected Notes – Only selected notes will be played.

Note: For simplified music, the staff here used is equal to a line of music.
Note: During playing, please avoid using non related functions such as editing functions.
The following are some options for playing:


Speed Adjust – It adjust the play speed. For example, 50% will slow down
the play speed by half. The method to determine the play speed is explained
in section 14.2



Ignore Tempo Signs – When this checkbox is checked, the tempo signs (see
section 14.2 for tempo signs used in the play) on the music will be ignored
and the music will be played with a constant speed （100 beats per minute）



Ignore Dynamic Signs – When this checkbox is checked, the dynamic signs
(see section 14.3 for dynamic signs used in the play) on the music will be
ignored and the music will be played with a constant volume



Show Play Position – When this is checked, the currently played notes will
be highlighted in real time. Please note that in this case you may see some
delay when switch page or rolling lines; this is because system takes a little
time to process the graphics. Obviously better graphic hardware can solve
this issue. If you want to play more smoothly, you can uncheck this option.

.
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14.2 Tempo Signs Used in Playing
Tempo signs are used to mark the playing speed. The playing recognizes many of the
tempo signs marked on the music. The tempo signs can be put at beginning of the piece
and middle of the piece as well. If it is put at beginning of the piece, it can be at any
places before the first note. If it is put at middle of the music to indicate the change of the
tempo, it can be put at the above or below the note where the tempo starts to change. In
the following example, you can see two tempo signs, “慢板” is at beginning of the piece
and “rit.” is close the end of the piece and is located at below the note “7”.

The following table lists all tempo signs that will be recognized by the playing. If the
music has no speed sign, it will be played at 100 beats per min.

Tempo Sign

Largo
极慢板
极慢速
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Larghetto,
慢板
慢速
Adagio
Andante
中板
中速"
Moderato
小快板
中快速
Allegro
快 板,
快速
Presto
快
Prestissim
特快
稍慢
稍快
rit,
rita,
渐慢
a tempo, 原速

Play at 65/min

Play at 75/min
Play at 85/min

Play at 100/min

Play at 120/min

Play at 160/min
Play at 200/min
Play slower (1/5 slower) than current tempo
Play faster (1/5 faster) than current tempo
These text symbols will slow down the tempo gradually. The
slow down process will continue until to the next tempo sign, or
to the end of piece.
These text symbols will restore the tempo.

There I need to mention triplets. In some music there are great amount triplets. To save
effort of mark all of them, we usually use a “Similar” mark to indicate that all notes that
has similar pattern afterwards will all treat as triplets. You can find “Similar” mark in
Commen Text Window (See section 3.9), you can also enter “Similar” as a text. The
software will honor this mark and play all triplet correctly without need triplet make. See
following example:
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14.3 Dynamic Signs Used in Playing
The playing recognizes many of the dynamic signed marked on the music. MusicWriter
gives maximum freedom to the uses to create the music. This freedom allows user to put
these signs to any places he wanted that creates uncertainty to the format. Therefore for
the playing to correctly interpolate the dynamic signs, we need restrict the dynamic
symbols only to be located BELOW the targeted notes. The following list gives all
dynamic signs that will be recognized by the playing and rules they need to follow.

Dynamic Symbol
ppp
最弱
pp
弱
p
中弱
mp
稍弱
mf
稍强
f
中强
ff
强
fff
最强
sf, sz
fp, sfp

Remark
play at 15% of the full volume
play at 25% of the full volume
play at 35% of the full volume
play at 45% of the full volume
play at 55% of the full volume
play at 70% of the full volume
play at 85% of the full volume
play at 100% of the full volume
suddenly louder, double current play volume
suddenly louder, double current play volume, then back
to normal volume.
crescendo, increase play volume gradually.

cresc.
渐强
diminish, decrease play volume gradually.
dim.
dimin.

渐弱

The following is an example:
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14.4 Other Recognized Signs
Turn Sign: The turn signs can be put at beginning of the piece and middle of the piece as
well. If it is put at beginning of the piece, it can be at any places before the first note. If it
is put at middle of the music to indicate the change of the turn, it must be put above the
note where the turn starts to change. In the following example, music start with turn F,
then it changes to Turn G.
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Shrink and Vertical Notes： Playing will honor the shrink and vertical notes. The
vertical notes will be played as a chord. For example:

Other Symbols: Besides all symbols mentioned above, the playing also recognize some
other signs. They are:

Signs

tr,

Remark
Trill, add above
targeted note

Example
,

Tremolo, add above
targeted note
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add above targeted
note
，
Decorate notes

Add before and after
the targeted notes.
，
Add above targeted
note. Play loud for
this note
Add above targeted
note. Play shot for
this note
Triplet or multi-let
notes. It has to be
add using the button

>

.

，

,

，

，

in dynamic
float window in
order for playing
correct.
play twice longer.
Add at front of
target note
，
Play as a serious
notes separately,
from low to high, or
high to low.
, D.C，D.S.

Repeat signs, notes
between repeat sign
will be played
twice.
Repeat skip mark.

Play 8 or 15 step
higher or lower.
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Play continuously
without stop
between notes.

14.5 Advanced Play Option

The speed and volume of the music will be automatically adjusted based on the
marks in the music. However, sometimes you may not satisfied with the choice by the
system and willing to specify them manually.


Rit. And Arpeggio Rate Adjust: To do so you need select a retardation mark,
like “rit.” , then set the desired value and press “Apply” button. A value
greater than 100 will make retardation slower and less 100 will make it faster.
Note that a very small number can make the retardation go to opposite way.
Same as arpeggio, you select a arpeggio note and enter desired value can
make the interval between each note longer (>100) or shorter (<100)



Crescendo Rate Adjust: You can select a crescendo or decrescendo mark,
such as cresc.，decresc.，
，
等，enter desired value and
press “Apply” key. Number greater than 100 make crescendo louder and
decrescendo softer. Vise vase.
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Note Volume Adjust: Allow you to adjust volume of individual note.



Change Play Duration: This one need more explanation. In very few cases
(only happens in complicated multi-part music) system may not play in
correct time duration. See the following example:

This is 4/4music piece. Note occupies 2 and half bits but it actually only
need play 1/2 bit before the following note need to start. In this case system
cannot tell this and will play the whole 2 and half bit before continue. To
solve this problem, you must manually set the duration of note
(8th note). Please note that the note
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15. Virtual Keyboard
Press the icon

intoolbar can open or close a virtual keyboard. See below:

You can use virtual keyboard to perform the following functions:
1. If you press any key on the keyboard, the corresponding sound will be ring.
2. If you check the “Output Notes”, the corresponding note will be written on the
selected cell. If the selected cell is on a western music staff, the western note will be
written. Otherwise a Jianpu note will be written.

3. If you want enter a cord note (vertical note), you can hold CTRL or ALT key then
press the required keys. When the CTRL or ALT key releases, the corresponding
cord note will be added.
4. When you play a music, the related key will be pressed so you can visually see which
keys are corresponding to currently played notes.
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16. GongChi (工尺) Music
GongChi music is a tradition music noting system that has been used for more the 1000
years. Though today it has not as popular as other notation systems but it still used in
some Chinese operas. And also this is a part of cultural for Chinese music and many old
music pieces are still written in GongChi. The purpose to have ability to write GongCh
in this program is to try to make contribution to preserve this age-old culture.
Simply click on menu item “GongChi” in “Window” menu at top tool menu or click on
icon
on tool bar, the system will turn int so called “GongChi” mode. Since GongChi
uses modified Chinese characters to record the notes, the cells will change to square.
Each square can host one GongChi characters. All GongChi characters will show on a
float window. See below:

In GongChi mode, you click on any button on the GongChi window will add
corresponding characters to the selected cell. You can also use number key 1-7, they are
corresponding to characters “上尺工凡六五乙”. Using “,” key you can add one or two
dot on the right-bottom of the characters to lower them by 1 or 2 octaves. Same reason,
you can use “’” key to raise them 1 or 2 octaves. The “,” and “’” keys can be applied
before or after the number key pressed. This rule is just as the same as in the simplified
notation. Other functions are same, such as move, copy, delete etc.,
When you close the GongChi window, system is back to normal mode. All other
functions are still works with GongChi notes. You can also mix GongChi notes with
Simplified notes, even mix with western notes.
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